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THE MOTIVE  FOR METAPHOR

by Wallace Stevens

You like it under the trees in autumn,

Because everything is half dead.

The wind moves like a cripple among the leaves

And repeats words without meaning.

In the same way, you were happy in spring,

With the half colors of quarter-things,

The slightly brighter sky, the melting clouds,

The single bird, the obscure moon—

The obscure moon lighting an obscure world

Of things that would never be quite expressed,

Where you yourself were never quite yourself

And did not want nor have to be,

Desiring the exhilarations of changes:

The motive for metaphor, shrinking from

The weight of primary noon,

The A B C of being,

The ruddy temper, the hammer

Of red and blue, the hard sound—

Steel against intimation—the sharp flash,

The vital, arrogant, fatal, dominant X.
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USER’S GUIDE TO ROCKJOCK -- A PROGRAM FOR DETERMINING

QUANTITATIVE MINERALOGY FROM POWDER X-RAY DIFFRACTION DATA

By  D. D. Eberl

ABSTRACT

RockJock is a computer program that determines quantitative mineralogy in powdered

samples by comparing the integrated X-ray diffraction (XRD) intensities of individual minerals in

complex mixtures to the intensities of an internal standard.  Analysis without an internal standard

(standardless analysis) also is an option.  This manual discusses how to prepare and X-ray

samples and mineral standards for these types of analyses and describes the operation of the

program.  Carefully weighed samples containing an internal standard (zincite) are ground in a

McCrone mill.  Randomly oriented preparations then are X-rayed, and the X-ray data are entered

into the RockJock program.  Minerals likely to be present in the sample are chosen from a list of

standards, and the calculation is begun.  The program then automatically fits the sum of stored

XRD patterns of  pure standard minerals (the calculated pattern) to the measured pattern by

varying the fraction of each mineral standard pattern, using the Solver function in Microsoft Excel

to minimize a degree of fit parameter between the calculated and measured pattern.  The

calculation normally analyzes the full pattern (usually 20 to 65 degrees two-theta) to find

integrated intensities for the minerals, but it also has the option to carry out an extended clay

analysis, in which a smaller region of the XRD pattern (usually 58 to 65 degrees two-theta) is

analyzed to find intensities for the clay minerals.  Integrated intensities for each mineral then are

determined from the proportion of each mineral standard pattern required to give the best fit.

These integrated intensities then are compared to the integrated intensity of the internal standard,

and the weight percentages of the minerals are calculated.  The results are presented as a list of

minerals with their corresponding weight percent.  To some extent, the quality of the analysis can

be checked because each mineral is analyzed independently, and, therefore, the sum of the

analysis should approach 100 percent.  Also, the method has been shown to give good results
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with artificial mixtures.  The program is easy to use, but does require an understanding of

mineralogy, of X-ray diffraction practice, and an elementary knowledge of the Excel program.

SUMMARY INSTRUCTIONS FOR QUICK START

Below is a brief summary of instructions for using RockJock:

1. Very important: After copying RockJock onto your hard disk, and upon opening the program

(for free expansion software see http://www.stuffit.com),  first run the Solver option in the

Full Pattern sheet.  If necessary, turn on the Solver in the Visual Basic Editor.  Then save the

program.  Do not change the program’s name (RkJock5.xls).  Macintosh users may need to

follow the more detailed installation instructions beginning on page 5 of this manual, as will

non-English language users.

2. Prepare samples for analysis by adding 0.111 g ZnO to 1.000 g sample.  Grind the mixture in

a McCrone mill for 5 minutes with 4 ml methanol.  Dry the ground sample, sieve, mix well,

side-pack the ground material into a holder to ensure random sample orientation, and then X-

ray from 5 to 65 degrees two-theta using Cu K-alpha radiation, with 0.02 degree steps and a

count time of at least 2 seconds per step.

3. Enter the X-ray diffraction (XRD) intensities for the sample into the Input sheet, column D,

with the sample name in cell D1.  To enter the data, use COPY and PASTE.  Never use CUT

and PASTE.  When pasting, under the EDIT menu, choose PASTE SPECIAL, VALUES.

Select the minerals likely to be present in the sample from the list in column G by entering a 1

(present) or a 0 (not present) in column H.  Enter option 2 in cell B22, click the Start button,

and wait and wait.  The Stevens poem, which concerns quantitative analysis, is meant to be

puzzled over while waiting.  Weight percents of the selected minerals in the sample will

appear in the Result sheet.  For best results, replace mineral standards in the program (see

Standards sheet) with ones that were run with your experimental setup, although adequate

results may be realized from the present mineral standards even though you are using a

different diffractometer.  When using a different diffractometer it may be necessary to turn on

the Auto Background correction in cell B16 of the Input sheet by setting it to 1.
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INTRODUCTION

A rock is composed of atoms that are arranged in variety of mineral structures.  To

characterize a rock, both the elemental composition and the mineralogy should be measured

quantitatively.  Sometimes the elemental composition is more important, as it would be, for

example, in prospecting for gold.  Sometimes mineralogy is more important, for example, if a rock

contains swelling clay that is cracking building foundations.  Often both measurements are

needed, for example, in the case of a gold ore which contains a clay mineral that may impede the

refining process.

The geochemical sciences have matured and prospered because they offer precise,

accurate, and routine methods for determining quantitatively the elemental compositions of

natural materials.  Quantitative mineralogy by XRD, however, has lagged far behind the chemical

methods, mainly because the quantitative analysis of clay minerals has proved to be a

particularly difficult problem (Moore and Reynolds, 1997).

This report describes the RockJock computer program, and gives instructions on how to

prepare and X-ray samples and standards for analysis by the program.  RockJock offers a

relatively simple and mostly automatic method for determining quantitatively the mineralogical

composition of samples, including clay minerals, to within a few weight percent from powder X-

ray diffraction data (see Appendix 10).  The calculations are based on three previously published

methods: (1) the matrix flushing technique of Chung (1974), in which integrated intensities of the

unknown minerals are compared to that of an internal standard (in the case of RockJock, ZnO,

zincite), thereby obviating the need for measuring the mass absorption coefficient for a sample;

(2)  the whole-pattern fitting routine of Smith and others (1987) for measuring integrated

intensities by fitting the sum of pure mineral patterns to that of the measured XRD pattern,

except that in RockJock key parts of the patterns which contain the 060 reflections for clay

minerals may also be fitted separately; and (3) the quantitative method of Srodon and others

(2001) for sample preparation, and for the method of measuring clay mineral content from non-

basal reflections rather than from the more commonly used basal reflections.



4

RockJock is similar in its approach to the recently released Microsoft Excel-based

program FULLPAT (Chipera and Bish, 2002), except that the analysis procedure in RockJock is

almost entirely automatic, and that RockJock contains a special routine (extended clay analysis)

that sometimes is useful for analyzing clay minerals.  Also, RockJock finds the integrated

intensity of the internal standard in an observed pattern by fitting the XRD pattern for the pure

internal standard (ZnO) to the observed pattern in the same manner as it does for the other pure

standard patterns.  The library standards in FULLPAT contain the internal standard (Al2O3), and

therefore, prior to analysis, these standards are normalized to an equal-internal standard basis so

that the internal standard in each library pattern has the same integrated intensity as the internal

standard in the observed pattern.

RockJock5 differs from previous versions of the RockJock program in that the standard

minerals were re-X-rayed using a higher resolution slit system, using sample rotation, and using

different sample preparation parameters, as is discussed below.  In addition, a different equation

(weighted residual square sum, or Rwp), rather than the degree of fit equation of Smith and others

(1987), is used to compare calculated and measured patterns.

Computer Requirements and Disclaimer

RockJock will run under either Windows 98 (or higher versions), or Macintosh (System

X) operating systems.  Calculation times are long, so the fastest computer available (>1 GHz)

should be employed.  The Excel program has not been optimized to run on the Macintosh;

therefore, a Windows system is preferred because it is faster.  One calculation can take up to half

an hour or more.  The more minerals that are selected to be present, the slower the calculation.

The calculation is slowed further if the AutoShift option is used.  Use of RockJock requires

installation of Microsoft Excel 2000 (or higher versions of Excel), including the Solver option

(which may not be installed in a standard installation from the original Excel disk), and an

elementary knowledge of how to use the Excel program.  In this report, the term “sheet” refers to

a worksheet in Microsoft Excel.  Cells, such as B4, designate column B and row 4.  It may be

necessary to use the English-language version of Excel (but see installation instructions below).
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RockJock works best on a computer having 100 megabytes or more of RAM.  The program

occupies about 50 megabytes of disk space.

Although this program has been used by the U. S. Geological Survey (USGS), no

warranty, expressed or implied, is made by the USGS or the United States Government as to the

accuracy and functioning of the program and related program material, nor shall the fact of

distribution constitute any such warranty, and no responsibility is assumed by the USGS in

connection herewith.

How to Obtain RockJock
The latest version of the software described in this report can be obtained by anonymous

ftp from the Internet address: ftp://brrcrftp.cr.usgs.gov/pub/ddeberl/RockJock, by emailing the

author at ddeberl@usgs.gov, or by writing D. D. Eberl, U.S. Geological Survey, Suite E-127,

3215 Marine Street, Boulder, Colorado, USA, 80303-1066.  The RockJock folder at the ftp site

can be opened by double clicking on the folder’s name (RockJock), and the files downloaded by

dragging them on to your hard disk.  The useful files are RkJock5.xls, which is the quantitative

analysis program; PkChopr.xls, which is the PeakChopper program that removes unwanted XRD

peaks; and RockMan5.pdf, which is the most recent instruction manual for the RockJock

program. Files can be decompressed using free software from: http://www.stuffit.com.

Comments or concerns about RockJock should be directed to the author.

Installation of RockJock
The following instructions should be followed exactly to setup the program to run for the

first time:

1.  Copy the program and related files onto your hard disk by dragging them from the ftp

site.  Do not change the name of the program (RkJock5.xls).   If by mistake you do change the

name of the program, the following error will appear when the program is run:

[RkJock.xls]Input!M376.  If the files are compressed with the .exe extension, they should

decompress automatically under Windows when double clicked.  Files with the .exe extension can
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be opened for the Macintosh if Aladdin expander software is used (see below).  Files with the

.sitx extension are for the Macintosh, and those with .zip are for Windows.  The latest version of

expander software can be downloaded free from the web at:  http://www.stuffit.com.  After

decompressing and opening the programs, more of the program can be viewed on the screen at

one time by reducing the zoom size under the View menu.

2.  After the program has been opened, go immediately to the Full Pattern sheet by

clicking that tab near the bottom left of the screen.  Under the Tools pull-down menu in this

sheet, check to see that the Solver tool appears.  If not, click the Add-ins option under the same

menu and click the Solver option box.  If the option does not install, then Solver has not been

installed from the original Excel disk.  Return to the original Excel disk and install the Solver (see

the Help menu in Excel), and then repeat the steps above.

3.  Next run the Solver once in the Full Pattern sheet by choosing the Solver from the

Tools menu and by clicking the Solve button.  If the following cells in the Solver are empty, then

before starting the Solver fill them in as follows:  Set Target Cell to E1; click the Min. button; set

By Changing Cells to E8.  This run will take a few minutes.  If the Maximum Time Limit box

appears click Stop and then OK.  If the Solver solution box appears, click OK to retain the Solver

solution.  This routine, and that described in the section below, should only have to be done once,

when the program is first installed on your computer, or if the program is installed on another

computer from your computer.

4.  Return to the Input sheet by clicking on its tab at the bottom of the screen.  Now it

probably will be necessary to turn on the Solver in the Visual Basic Editor.  If this Solver has not

been turned on, the program when run will give: Macro error at cell: [RkJock5.xls]Input!AJ210.

To turn on the Solver, go to the Tools menu.  Under Tools, choose Macro, then Visual Basic

Editor.  A new Tools menu will appear.  Under this menu choose References.  A box will appear

named Available References.  Click to check the Solver box in this box, and then go to paragraph

5 below.  If the References option is dimmed so that it can not be chosen, then exit the Excel

program (first exit the Visual Basic editor under the File menu and then exit Excel), and start again

with step 2 above.  It may be necessary the second time through to uninstall and then to reinstall
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the Solver (under the Tools menu in the Full Pattern sheet click Add-Ins, and uncheck the Solver

Add-in box, then repeat the procedure to recheck the Solver box).  However, no Solver box may

appear, or a checked box may appear that says MISSING:SOLVER.XLA.  If so, click the

Browse button.  You now will have to look around to find the Solver box in order to check it to

turn it on.  In one version of Excel, twin boxes will appear.  From the menus at the top of the

boxes, it may be necessary to find Microsoft Excel Files in the Show menu and Add-Ins in the

From menu (look in the Microsoft Office files under the Excel program and in Libraries).  Make

sure that All File Types are being shown, or especially those having the .xla extension.  Choose

Add-Ins in the left box, and open Solver.xla in the right box by double clicking.  Click the Enable

Macros button that appears.  In a minute, SOLVER with a checked box should appear in the

Available References box.  Click the OK button.  Under the File Menu, click Close and Return to

Microsoft Excel.

5.  If the Visual Basic editor is open, close it under the File menu.  In the Input sheet, go

to cell AJ260, which will have a pink-colored font.  This cell should show:

=SOLVERSOLVE(TRUE).  This macro statement can be seen at the top of the screen, in the

formula bar beneath the Tools bar.  If the equation cannot be seen, then under the Tools menu,

click Options, and then under the View tab check the Show formula bar option.  The Status bar

and Windows in Taskbar options also should be checked.  If cell AJ260 shows only

=SOLVERSOLVE(TRUE), save the program and go to the next section in this report.  However,

especially for the Macintosh, there may be a long string of letters after the equal sign in this

macro statement indicating the address of a hard disk.  If this information is present, it must be

removed from this and other cells before the program will run.  To remove it, copy everything

that comes between the equal sign and SOLVERSOLVE(TRUE) by highlighting it, and choosing

Copy from the Edit menu.  Click the red X in the Formula bar to return the cell value to its

original state.  Under the Edit menu, choose Replace.  (In some systems it may be necessary to

choose Find first, and then Replace.)  Paste the copied material into the Find What box.  Do not

enter anything into the Replace With box.  Click the Replace All button.  Now the unwanted

material has been removed from all cells in the program.  Save the program, and you are ready to
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start to use it. The program inputs and outputs are described in detail in Appendices 1 through 8

of this manual.  Appendix 9 lists resources for quantitative analysis, and Appendix 10 gives

RockJock analyses of the Reynolds Cup samples, samples which were used in international

quantitative analysis competitions.

6.  RockJock can run under non-English language versions of Excel if the user is willing to

do some work.  Most of the code is translated automatically into the non-English version, but

there are a few words that must be changed manually.  RockJock has been run successfully in the

Spanish-language version of Excel, and the following can be used as a guide for what changes need

to be made.  To replace words in the program, follow the instructions in paragraph 5 above.  The

word “Chart” needs to be changed to its non-English equivalent.  For example, cell M375 in the

Input sheet reads =SELECT(“Chart 3”), where Chart refers to the graph that contains a plot of

the X-ray pattern.  The word Chart in this cell, and in all other cells in the program, should be

changed to the non-English equivalent that can be found in the non-English Excel instructions.  As

an example, in the Spanish language version of Excel this word is Gráfico, with the accent.  Under

the Edit menu Replace all Chart with Gráfico.  Next, if present, clear SOLVER.Xla! from the Full

Pattern sheet (replace this phrase with nothing).  Then it is necessary to replace the word

SOLVER with the non-English equivalent.  In Spanish the word is SOLV (see Excel instructions

to find the word).  Finally, the Solver commands need to be modified in the Full Pattern sheet

(Cells C61:C71 and D61:D63), as follows.  Go to the Full Pattern sheet.  Click on cell C61 to

choose it.  Under the Tools menu choose Solver.  Make the following changes in the Solver box

that appears on the screen:  under By Changing Cells, erase the current entry and type $E$7;

under Subject to Constraints, choose each entry and click Delete so that this box is empty.  Next

click on the Options button which is a part of the Solver box that is on the screen, and then click

the Save Model button.  Click OK, OK, and close the Solver box.  Now cells C61:C63 should

contain the non-English language equivalent of the English entries.  It may be necessary to

separate the entries in Cell C63 with slashes (/) rather than with commas or semicolons (, or ;), or

maybe not.  Now repeat the same procedure with cells C65:C67, C69:C71, and D61:D63.  When
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finished, change the 9th entry in cell D63 from 1 to 2 (…1,1,1… to …1,2,1…).  Save it, and, if

the program runs, give thanks.

Acknowledgments
The author thanks Alex Blum, Dan Kile, Cathy Rubin, and Howard Taylor for reviewing
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RUNNING ROCKJOCK

After saving the newly installed program, paste an XRD pattern (5 to 65 degrees two-

theta with 0.02 steps and at least 2 seconds count time per step) for a sample into column D in

the Input sheet.  The intensities should start in cell D2, with the sample name in cell D1.  For

practice, use the French healing clay pattern that currently is in column D, or use the Reynolds

Cup patterns that are stored in the Auto XRD sheet.

In order to use intensities from an X-ray diffraction system, the intensities must be

converted into an Excel worksheet format.  For instruments using Jade software, the X-ray files

are converted into text files using Jade, and then the text files are opened using Microsoft Excel

by choosing Open from the Excel File menu, and then by choosing the text file that is to be

opened.  The Text Import Wizard box then appears.  Choose the Delimited option; click Next;

choose the Delimiter Space; and then click Finish.  The intensities, which should start at 5

degrees two-theta, now can be copied and pasted into RockJock.

Select whether the mineral is present or not by entering a 1 or a 0 into column H next to

the mineral’s name on the Input sheet.  A limit of 40 minerals may be selected to analyze at one

time.  It also is possible to select how the mineral will be reported by changing the values in

column K (for a non-clay enter 2; for a clay enter 3; or for no report enter 1), and whether or not

the mineral may be subjected to extended clay analysis, should this option be chosen in cell B22,

by changing the settings in column J (for extended clay analysis, enter a 1 for the chosen mineral

in column J).  These two columns already have been optimized for the minerals listed.  Minerals

also can be chosen to undergo AutoShift by entering a 1 in column I, as will be discussed below.

Check on the Full Pattern sheet that cells C6 to C47 are set to zero.  These cells shift the

standard patterns in steps of 0.02 degrees two-theta, and can be set to zero automatically by

entering -1 in cell B14 of the Input sheet, and by starting the program (enter the number for any

option in cell B22, and click the Start button).

To analyze a single sample after having chosen the minerals present, set cells B11, B14,

B16 and B18 to 0, and B22 to 2.  Press the Start button.  The weight percents will appear

automatically in the Result sheet at the end of the calculation.  The total may differ from 100
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percent by plus or minus 5 percent or more, because each mineral is analyzed separately, and

there are small, unavoidable inaccuracies due to sample preparation (especially due to

inhomogeneous mixing of zincite and sample) and to variability in the chemistry, orientation and

microstructure of the minerals.  Weight percents for the Reynolds Cup samples (stored in the

Auto XRD sheet) may total to considerably more than 100% because they were prepared and X-

rayed differently than the recommendations given here, and therefore do not perfectly fit the

standards currently found in the program.  However, accurate results are achieved for these

samples by normalization to 100% (see Appendix 10).

After the calculation, check the graphs in the Full Pattern sheet to see the goodness of fit

between the calculated and measured X-ray intensities. The red, calculated pattern should match

the blue, measured pattern.   If some peaks are not accounted for, more minerals may have to be

chosen present in column H of the Input sheet, or the intensities of one or more of the standard

XRD patterns may have to be shifted (discussed in the following paragraph).  The two theta

angle for a peak can be found by pointing the mouse arrow to the peak maximum.  The last

worksheet in the program, Common Lines (Brown and Brindley, 1980), is helpful for identifying

XRD peaks for common minerals.  Calculations of Bragg’s Law for converting two-theta angles

into d-spacings, and vice versa, also can be found in this sheet.

Due to isomorphous substitutions, peak positions may vary for the same mineral

between the standard mineral and the mineral in the sample.  Peak positions for individual

minerals can be shifted right or left by entering a plus or a minus whole number into the cells with

the red zeros (in column C of the Full Pattern sheet), which are adjacent to the minerals to be

adjusted.  A smaller number for the degree of fit in cell E1 of the Full Pattern sheet can be used as

an indication of how far to shift the patterns.  Once the peak positions have been adjusted, the

program can be run again.  This shift also can be accomplished automatically by entering a 1, 2 or

3 in cell B14, and by indicating which minerals are to be shifted in column I of the Input sheet.

Before running a new sample, be sure to check that all of the shift cells in the Full Pattern sheet

(in column C) have been returned to zero [enter minus 1 (–1) in cell B14 in the Input sheet and

start the program to return them to zero automatically].
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X-ray patterns of artificial mixtures that were used in an international quantitative

analysis competition, the Reynolds Cup, are included with the program (see the Auto XRD sheet

in the program and Appendix 10 in this manual).  The 2002 Reynolds Cup samples (RC-AR1,

RC-AR2, RC-AR3) require peak shifts, +12 for siderite because the sample contains a

phosphosiderite rather than the carbonate siderite used as a standard.  This shift can be done

automatically by setting Input sheet cell B14 to 1 or 3, and cell I24 to 1.

EXTENDED CLAY ANALYSIS

This option is unnecessary for most users, because it has been found that full pattern

analysis is sufficiently accurate.  The option was left in the program because it may prove to be

useful for some samples to analyze clay minerals in the 58 to 65 degree region of the XRD

pattern, rather than in the full pattern (20 to 65 degrees).  This type of analysis is accomplished

by entering a 3 into cell B22 of the Input sheet, and by choosing the minerals to be analyzed in

this manner in column J of the Input sheet.  If this option is chosen, results for both types of

analysis are reported in columns J and K in the Result sheet.  Both full pattern and extended clay

analyses were carried out for artificial mixtures (Reynolds Cup samples), samples for which the

mineralogies were known, to test the two methods of calculation.  The calculated biases, given in

table 1, sometimes indicate a small advantage for the extended clay analysis method if all of the

2:1 clays in a sample are reported as a single phase. The biases given in table 1 are a measure of

the accuracy of the determination.  Bias is defined as the sum of the absolute differences between

the weight percent of each mineral used in the artificial mixture and the weight percent determined

by the RockJock program.  More recent analyses of the Reynolds Cup samples using RockJock5

are reported in Appendix 10.
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Table 1.  Biases calculated for two methods of analysis, Option 2 (full pattern analysis) and

Option 3 (extended clay analysis), in the RkJock2.xls program.

Sample Full Pattern analysis bias Extended clay analysis bias
RC-AR1 13.7  (12.7)* 7.6*
RC-AR2 9.4  (9.1)* 15.7*
RC-AR3 15.4  (11.2)* 12.0*
RC2-1 9.3  (9.3)* 9.8*
RC2-2 8.1  (8.1)* 6.2*
RC2-3 11.7  (10.1)* 8.9*

*Weight percents for 2:1 clays were added together to calculate bias.

USING THE AUTOMATIC MODE

RockJock can analyze a group of similar XRD patterns in one continuous run of the

program, using a single set of mineral standards.  Although analysis time for each pattern may be

long, the program can run for about 9 hours (32,000 seconds, which is the maximum time

allowable in the Solver, although sometimes it runs longer) without further input, at which time a

Continue button that appears on the screen may have to be clicked to continue the analysis.

Enter the XRD patterns into the Auto XRD sheet in the columns that are indicated in this

sheet.  In the Input sheet, set cell B11 to the number of XRD patterns to be analyzed; set the

minerals present in column H; set cell B22 to 2; and click the Start button.  At the end of the

calculation, the results are saved automatically (see cell M29 in the Input sheet), and the results

themselves are in the Auto Results sheet.  Graphs for the analysis of each sample can be studied

in the Auto Graph sheet by entering the analysis number of the pattern (1, 2, 3, etc.) into cell A2.

The analysis number of the patterns can be found in the top row of the Auto Results sheet.

The Auto Graph sheet can be copied and saved separately as a record of the analyses.  To

do this, click on the Auto Graph tab near the bottom of the screen to select this sheet.  Under the

Edit menu, select Move or Copy Sheet.  Under To Book select (new book), and check the Create

a Copy box.  Click the OK button.  When the new worksheet is ready, under the File menu,

choose Save as, and give the worksheet a name with an .xls extension (e.g., Yukon.xls).  The Auto

Results sheet also can be saved as a part of the new workbook by copying the Auto Results
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sheet (drag through it and copy), by creating a new sheet as a part of the new workbook (choose

the new workbook, and under the Insert menu choose Worksheet), and by pasting the auto

results into the new sheet.

MANUAL MODE

The Input sheet in RockJock can be used to find XRD peak positions, integrated peak

intensities, and integral peak breadths.  To do this, enter the XRD pattern into Column D in the

Input sheet.  Set the start angle, step size, and radiation wavelength in cells B5, B7 and B9.  Set

cell B22 either to 0 or to 1, depending on whether the sample has a ZnO internal standard.  Next

set the angles in cells C4 and C6 to bracket the minimums of the peak to be measured.  Set cells

C8 and C10 to either 0 or 1.  If zeros are entered, the peak will be picked between the values

entered into cells C4 and C6.  If ones are entered, the peak will be picked from minimum

intensities on either side of the peak.  Next set the background removal option in cell C13.

Entering a 0 does not remove background, and this is the option selected automatically during

quantitative analysis.  Entering 1 or 2 causes the background to be picked from the minimum on

the left or right side of the peak, respectively.  Entering 3 causes the background to be picked

from a line drawn between the minimums on the left and right sides of the peaks.  Entering 4

causes the background to be selected from the pattern minimum (between 6 and 64 degrees two

theta).  After either 0 or 1 is entered into cell B22 and the program is started, the manner in which

the background was determined is drawn on the chart in the Input sheet.  The results, which

include the position of the peak’s maximum intensity, the analytical range for the peak, the

peak’s maximum intensity, the positions of the peak’s minimums, the peak’s integrated

intensity, and the peak’s integral peak breadth, appear in column A.
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SAMPLE PREPARATION AND ANALYSIS

Samples and standards should be prepared according to a method modified from that

reported in Srodon and others (2001).  It is important that these instructions be followed closely.

A sample weight of 1.000 g is mixed with 0.111 g of ZnO, passed through the McCrone sieve,

and ground with about 4 ml of methanol in a McCrone micronizing mill (Appendix 9) for 5

minutes (use the corundum grinding elements).  The mixture then is dried at about 85° C and

sieved again (500 micrometer sieve, or the slightly finer 400 micrometer McCrone sieve).  The

sample plus zincite mixture usually can be passed through the sieve using a relatively stiff brush,

but hard samples may have to be hand ground first.  The mixture then is stirred again, and, to

insure sample randomness, side packed into an XRD holder against frosted glass (obtained from

Ward’s Natural Science; Appendix 9) by tapping the holder on a hard surface.  It is important

that the ground, dried and sieved mixture be thoroughly mixed (separation of zincite occurs on

drying), and that a representative sample of the sample plus zincite mixture be packed into the

holder.  Samples should be X-rayed from 5 to 65 degrees two-theta using Cu K-alpha radiation,

with a step size of 0.02 degrees two theta, and a count time of at least two seconds per step

when using a scintillation counter.  Patterns that have been run using a radiation wavelength other

than Cu K-alpha need to be converted into this radiation wavelength before being entered into the

Input sheet.  Such patterns can be converted by pasting them into column B in the Wavelength

Conversion sheet in the RockJock program.  Note that the converted pattern needs to span a

minimum two-theta range from 5 to 65 degrees.  Be sure that the Analysis ToolPak is installed in

the Wavelength Conversion sheet, as is described in the sheet.

Samples can be run without an internal zincite standard.  For this standardless analysis,

approximately 1 g samples are ground as described above without adding ZnO, and option 4 is

entered into cell B22 of the Input sheet.   In addition, the Shifter sheet needs to be changed from

shifts against ZnO to shifts against quartz (enter 3 in cell B7 of the Shifter sheet), which will be

present naturally in most samples, to no shift (enter 4 in cell B7), or to shifts against another

position standard (enter the standard’s XRD pattern into column J of the Shifter sheet, enter 5 in

cell B7, and enter the two-theta angles that encompass the position standard peak in cells
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B13:B14).  Standardless analysis is normalized automatically to 100 percent.  Therefore, there is

no independent check as to whether or not all minerals present in the sample have been included

in the analysis.  Otherwise, the two types of analysis should give comparable results.

ENTERING NEW MINERAL STANDARDS INTO THE PROGRAM

The mineral standards that are now in the program have been run on a Siemens D-500 X-

ray diffractometer with the following experimental setup for the X-ray beam: X-ray tube (Cu), 1

degree slit, soller slits, 1 degree slit, sample, 1 degree slit, no filter, 0.05 degree slit, graphite

monochromator, 0.6 degree slit, scintillation detector.  For the most accurate determinations, a

replacement set of mineral standards (see below) should be developed by the user; however,

mineral standards in the current program provide an immediate opportunity for practice and give

adequate results for many purposes.  Artificial mineral mixtures can be used to test the accuracy

of the current mineral standards.  It is important to test the automatic background correction

when using the current program’s mineral standards with XRD patterns from your instrument to

see if this correction is necessary (set cell B16 in the Input sheet to 1; see below).

Table 2.  Biases for 2002 Reynolds Cup samples run on different diffractometers (1, 2 and 3)

analyzed using standards run on diffractometer 1 (Siemens D500).  Results were calculated with

an earlier version of RockJock.

Sample: RC-AR1 RC-AR2 RC-AR3

Diffractometer: 1 2 3 1 2 3 1 2 3

Bias: 6.8 7.8 13.7 9.6 15.0 13.9 13.3 11.8 26.6

Good results have been obtained thus far, based on limited data, by analyzing samples X-

rayed on different machines using the Siemens-generated intensities for mineral standards that are

currently stored in the program (table 2).  The analyses reported in table 2 were run in a previous

version of the RockJock program (RockJock.xls rather than the current RkJock5.xls).  The best

determinations were those that used standards that were X-rayed with the same instrument that
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performed the measurement (Siemens D500; columns labeled “1” in table 2), yielding a total bias

of 29.7 for the three samples.  Diffractometers labeled 2 and 3 gave total biases of 34.6, and 54.2,

respectively, indicating that, although it would be best to develop individualized standards,

acceptable analyses may be made with the standard set that is presently in the program.

Diffractometer 3 used a different type of detector (possibly defective) than that employed for

diffractometers 1 and 2.  It may be necessary to use a slit system that is similar to the

experimental setup described in the first paragraph of this section.

If there are problems with background (for example, if the background from your

instrument is different than the background for the stored standards), one can let the background

be a part of the Solver solution by setting cell B16 in the Input sheet to 1.  If your zincite pattern

is subtly different from the stored pattern, artificial mixtures (e.g., 0.5 g each of kaolinite and

quartz, plus 0.111 g ZnO) can be analyzed to test the zincite standard.  If the RockJock values

are consistently different from 100 percent, then the ZnO correction factor can be adjusted in the

Result sheet, cell O2.  For example, if you always have a total around 93% (46.5 % quartz + 46.5

% kaolinite) rather than 100 percent, then cell O2 in the Result sheet can be set to 1.075 (e.g.,

100/93 = 1.075).  A new zincite standard also can be entered into the program by pasting the

two-theta justified zincite pattern into column  L of the Full Pattern sheet, and by entering the

integrated intensities for this pattern into cells D3 and F3 of the Standards sheet.  These

intensities can be determined using the Input sheet, as is described below.

If new standards are to be developed:

1.  First enter a pattern (5 to 65 degrees two-theta with 0.02 degree steps and at least 5

seconds count time per step) for pure ZnO (obtained from Fisher Scientific, Certified A.C.S.,

Dry Process; 1 g ground in a McCrone mill with 4 ml of methanol) into column D of the Input

sheet, and plot it by entering 1 in cell B22 and clicking the Start button.  Next copy the modified

pattern, which has automatically been smoothed (using a moving average of 3) and shifted with

respect to the ZnO standard currently in the program, from cells S2:S3002 in the Input sheet, and

paste it into column L of  the Full Pattern sheet (under the Edit menu, choose Paste Special,

Values).  Fill in zero cells at either end of the pattern with adjacent values.  This pattern will have
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been shifted automatically during plotting so that the XRD peaks have “true” positions when

compared with published values (e.g., check that the 110 zincite reflection maximum is at 56.64

degrees two-theta for Cu K-alpha radiation).  Use exactly this same ZnO chemical in all analyses.

2.  Next determine the ZnO integrated intensities in two regions of the pattern (the full

pattern region, from 20 to 65 degrees two theta, and the clay region, from 55 to 65 degrees two

theta), as follows.  Enter a position-corrected but not smoothed ZnO pattern into column D on

the Input sheet (e.g., if necessary, shift the pattern manually), with intensities starting at 5

degrees two-theta in cell D2.  Set cells C4 = 20, C6 = 65, and cells C8, C10, and C13 to 0.  Set

cells B11, B14, B16 and B18 to 0 and cell B22 to 1, click the Start button, and record the

integrated intensity for the Full Pattern region (cell A15 in the Input sheet).  Next set cells C4 =

55 and C6 = 65.  Click the Start button, and record the calculated integrated intensities for the

standard for the Clay region found in cell A15.  Enter these integrated intensities into the

Standards sheet, cells D3 and F3, respectively, and save the program.

3.  According to the instructions in Srodon and others (2001), two X-ray patterns (with

at least 5 seconds count time per step) are prepared for each mineral standard, one for the pure

mineral (about 1 g), and the other for a mixture of the pure mineral (0.400 g) with either a clay

(0.400 g  pure kaolinite) if the mineral is a non-clay, or with a non-clay (0.400 g pure quartz) if

the mineral is a clay, plus the internal standard (0.200 g of ZnO).  The mixture is ground in a

McCrone mill for at least 5 minutes in 4 ml of methanol, except for pure clay standards, which

should be ground for 20 minutes in 4 ml of hexane to ensure random orientation.

4.  The pattern of the pure mineral needs to be justified in two-theta space with respect

to the pattern that contains the ZnO internal standard.  To do this, paste the XRD pattern for

the ZnO-containing standard mineral into column D in the Input sheet.  Enter 1 into cell B22  and

click the Start button.  This operation will plot the XRD pattern shifted against the position of

the ZnO internal standard.  Choose a mineral XRD peak (not a ZnO peak, or the kaolinite or

quartz additions), and determine its position by entering angles that are on either side of the peak

into cells C4 and C6.  Push the start button again.  The two-theta peak position for this peak will

appear in cell A4.  Note this position.  Now enter the X-ray intensities for the pure mineral into



19

column D.  Set cell B22 to 0 and click the Start button.  (The number 1 is not entered into this

cell because the pure mineral does not have an internal ZnO standard against which to shift the

pattern.)  The peak position for the pure mineral now appears in cell A4.  This position should

be the same as the angle noted for the ZnO-containing sample.  If it is not the same, then

manually shift the pattern of the pure mineral in a separate Excel worksheet by the number of

steps necessary to make the peak position found for the pure mineral the same as that found for

the ZnO-containing sample.  Remove or insert intensities, having approximately the same value

as adjacent intensities, at the top or bottom of the X-ray intensity data in order to have the

shifted pattern vary from 5 to 65 degrees.

5.  Next measure the integrated XRD intensities for the pure mineral in two regions of the

pattern (the Full Pattern region and the Clay region), as was done for the ZnO pattern, and as is

repeated here.  Paste the shifted XRD pattern (see item 4 above) for the pure mineral into column

D on the Input sheet.  Set cells C4, C6, C8, C10, and C13 to 20, 65, 0, 0, and 0, respectively.

Click the Start button, and record the integrated intensity for the Full Pattern region (cell A15).

Next, set cells C4 and C6 to 55 and 65, respectively.  Click the Start button, and record the

integrated intensities for the mineral standard for the Clay region found in cell A15.

6.  The manually shifted pattern for the pure mineral and the integrated intensities now

must be entered into the Standards sheet.  The smoothed, manually shifted pattern for the pure

mineral standard first is copied from cells O2:O3002 of the Input sheet.  Click the tab for the

Standards sheet.  Enter the shifted XRD pattern for the pure standard mineral into the correct

column, starting in column M.  Note that the position of the mineral in the Standards table is

keyed to the column of the mineral’s pattern starting in column M.  Enter the mineral name into

column C, the integrated intensity for the Full Pattern region into column D, and the integrated

intensity for the Clay region into column F.  When the program is run, the name of the new

standard will appear automatically in column G of the Input sheet.

7.  Next measure the mineral intensity factor (MIF), which compares the integrated

intensity of the mineral to that of the internal standard.  MIF is defined as:



20

MIF =
Im %S( )
Is %M( )

, (1)

where Im and Is are the integrated intensities of the mineral and the ZnO standard, respectively,

and %S and %M are the weight percents of the ZnO standard (20 percent) and the mineral

(usually 40 percent).  The term MIF is defined the same as the reference intensity ratio (RIR) of

earlier literature (Snyder and Bish, 1989); but the acronym MIF is preferred here because it is

easier to pronounce.  To measure the MIFs, set the “Present?” values in column H of the Input

sheet to 1 for the mineral and for the material that the mineral is mixed with (a disordered

kaolinite, such as KGa2, is mixed with a non-clay standard, and quartz is mixed with a clay

standard).  All other settings in column H should be zero, except for cell H73 which is set to 1 to

account for corundum contamination during grinding.  Set the values in columns J and K as

indicated at the tops of the columns.  The cell in column K should be set either to 2, in which

case the mineral is to be reported as a non-clay, or to 3, in which case it is to be reported as a clay

mineral.   Cell K73 for corundum should be set to 1 (no report).  The cells in column J are set

either to 0 or 1, depending on whether or not the mineral will be analyzed as a clay in optional

extended clay analysis, to be discussed below.  Do not use the AutoShift option.  Now set cell

B22 to 3.  Click the Start button.  When the calculation is complete, the MIFs for the full pattern

and clay region analyses can be calculated, using equation 1, from the integrated intensities given

in columns Q and AA in the Results sheet.  However, the MIF solutions also are presented

automatically in columns U and AE in the Results sheet.  Solve for kaolinite and quartz standards

first, because these minerals are used in subsequent calculations.  The MIF values now should be

entered into columns E and G in the Standards sheet in the appropriate cells.   The MIFs can be

checked by running the pattern again with the new MIFs in the standards table.  However, cell

C211 in the Input sheet should be set to 0.25, because a different zincite sample ratio is used to

measure MIFs for mineral standards from that used to prepare normal samples.

Impure standards also can be used.  If, for example, a clay standard contains a quartz

impurity, the peaks for quartz in the “pure” pattern of the clay can be removed electronically

using the PeakChopper program that accompanies the RockJock program.  Its corrected X-ray
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pattern and integrated intensities from this pattern then are entered into the Standards sheet as

described above. The ZnO + quartz spiked clay standard sample then is run as described above,

except that cell C21 in the Input sheet is set to 0.25 for the ZnO/sample ratio used with the

mineral standards [0.25 = 0.2 g ZnO/(0.4 g clay + 0.4 g quartz)].  After the calculation, the

amount of quartz in the sample can be read in the Result sheet.  For example, if the result of the

calculation is 58 percent quartz, then the amount of quartz in the original clay sample was 8

percent (58 percent minus the 50 percent quartz added to the clay).  In solving for the MIFs in

equation 1, recall that the sample as made up contained only 40% of the standard.  Thus, %M  =

40 – (40)(8)/50 = 33.6, %S = 20, and Im and Is can be read in columns Q (for the full pattern

MIF) and AA (for the clay region MIF) in the Results sheet.  Do not use the automatic solutions

found in columns U and AE in the Results sheet in this case.  MIFs for mineral standards that

contain impurities also can be calculated automatically by filling in the red cells in BA1:BB12 of

the Results sheet.  Other impurities can be handled in a similar manner.  Be sure to return cell

C21 in the Input sheet to its original value [0.111 = g ZnO/(g sample) for a normal sample

preparation] before running more samples.

MEASUREMENT ACCURACY

During the process of measuring MIFs for the RockJock5 program, many measurements

were made of the weight percents of kaolinite (KGa2) and quartz mixed 50:50 with a range of

other minerals.  From these measurements, the standard deviation and standard error at 50 weight

percent kaolinite or quartz was calculated (Figure 1).  This calculation yields errors for kaolinite

and quartz of approximately ±3 weight percent (1 standard deviation) at 50 weight percent.

The accuracy of RockJock5 analyses also can be inferred from analyses of Reynolds Cup

samples (Appendix 10).  For the 2002 samples (Appendix 10, table 3), the combined bias for 3

samples is 35.9, and that for the 2004 samples (table 4) is 27.6, if the results are normalized to

100 % and if similar clays are combined into single categories, as was done during the judging of

these contests.  Bias is defined as the sum of the absolute difference in weight percents between

the true values and the RockJock calculated values.  As was mentioned previously, sample
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preparation, using instructions for a previous version of the program, was not ideal for the

RockJock5 program standards.  A leading Rietveld analysis program, with the data reduced in a

similar manner to the RockJock data, gives combined biases of more than 85 for each sample set.

The data in tables 3 and 4 also indicate that RockJock is very good at qualitative analysis.

All of the phases contained in each contest were entered as being present in each analytical set.

The only significant mistakes were in failing to detect 7.0 % ferruginous smectite in sample RC-

AR1 (table 3), and in giving sample RC2-3  3.2 % kaolinite when none was present (table 4).

The Rietveld program was not as good at qualitative analysis.
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Figure 1.  Measurement error for kaolinite and quartz measured for samples containing 50 weight

percent of these minerals.
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USEFUL TIPS

To stop the calculation at any time, press the Escape (Esc) key.  This key also can be

pressed to study calculation progress during Solver solutions.  To update the graphs during the

Solver calculation, press the Esc key, and then click the Continue button that appears on the

screen.

Pointing to a pattern in the graphs will bring up the mineral name associated with that

pattern and the two-theta angle.

AutoShift works better for fewer minerals.  Some phases which contain isomorphous

substitutions may require AutoShift (e.g., illite), whereas others which are relatively pure (e.g.,

quartz) do not, although, for an unknown reason, quartz sometimes is shifted by one step.  Such

small shifts usually do not significantly affect the results of the calculation.

If a chart is selected on a sheet subsequent to the Input sheet, the program will not run,

and a Macro error message will appear.  To fix this problem, go to the sheet, click on any cell to

unselect the chart, and start the program again.

When running extended clay analysis, all of the weight percents of the 2:1 clays should be

added together and reported as illite + smectite, because illites and smectites have nearly the same

pattern of reflections in the clay region.  Another technique has been developed (PVP surface area

technique; Blum and Eberl, 2004) to distinguish between smectite and illite with the aid of

RockJock and MudMaster calculations.

Fe-smectite is a common phase in sediments, but it can give a false-positive reading in

RockJock.  Be sure that your sample contains smectite before selecting this mineral by studying

the low-angle region of the pattern.  Treating oriented samples with ethylene glycol is especially

helpful for uncovering the presence of smectite.  Other patterns that do not have a well defined

series of XRD peaks (e.g., volcanic ash, peat, etc.) also may give false positive readings.

Check the pattern’s low angle region to see if minerals that have peaks in this region

should be included in the analysis.  Some of these minerals are: smectite (6 to 8 degrees two

theta), illite and mica (8.8 degrees), chlorite (6.2 degrees), amphibole (10.5 degrees), gypsum

(11.6 degrees), bassanite (14.8 degrees), alunite (17.9 degrees), etc.  If these peaks are not found,



25

then the mineral should not be included in the analysis, although the program often can solve this

problem automatically.

If extended clay analysis is chosen (by entering a 3 in cell B22 in the Input sheet) minerals

are solved for weight percents in both the Full Pattern and the Clay regions, but the solutions are

only reported in columns C and E of the Results sheet for the region selected for each mineral

(region is selected in column J of the Input sheet).  One can compare the solutions found for a

given mineral in the two regions by comparing columns J and K of the Result sheet.  The

solutions may not be exactly the same, because, for example, intensities for non-clays may be

very small in the clay region, and, therefore, the solution for non-clays in the clay region is

inaccurate, or because the clays’ basal reflections in the full pattern region may differ from those

of the standards.  Generally, the effect of such differences on the final result has been found to be

small.

If there is a question as to which feldspar is in a sample, select all of the feldspars the first

time through, and then eliminate those that are less than 1 weight percent for the final calculation.

The same strategy works, for example, with chlorite, smectite and illite.

Several different regions for analysis can be set in the Full Pattern sheet, cells B4 through

B9.  This option is useful if a mineral has a distinctive peak outside the normal analysis range of

20 to 65 degrees.  For example, gypsum has a strong peak at 11.6 degrees two-theta (Cu

radiation).  In this case, cells B4 and B5 can be set to the normal values of 20 and 65, and cells B6

and B7 can be set to 11 and 12 to include this gypsum peak in the analysis.  Low-angle clay

peaks, especially those for illite and chlorite, generally are too variable to be useful in this type of

approach.  Likewise, some peaks, such as the most intense quartz peak at 26.64 degrees two

theta, can be excluded from analysis by manipulating cells B4 through B9 in the Full Pattern

sheet and cell M31 in the Input sheet.  For example, to exclude the strongest quartz peak, set cell

M31 in the Input sheet to 25, and cells B6:B7 in the Full Pattern sheet to 27 and 65,

respectively.

After an initial solution for a sample, the answer can sometimes be improved by shifting

the mineral standards with respect to two-theta to minimize the degree of fit value in cell E1 in
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the Full Pattern sheet.  Standards can be shifted manually by entering positive or negative whole

numbers into the appropriate cells in column C.  The shifting also can be automated by entering a

1, 2 or 3 into cell B14 of the Input sheet, and by choosing the minerals to be shifted in column I

of the Input sheet.  Calculations that include automatic shifts are slower.

The 060 reflections for clay minerals generally shift towards smaller two-theta angles

with increasing iron content.  Similarly, the dominant dolomite peak shifts to smaller angles with

increasing iron content.  Increasing magnesium content causes the most intense calcite peak to

shift towards larger angles.

In extended clay analysis, do not run different polytypes of the same mineral in different

regions for a given analysis.  For example, if 2M1 illite is analyzed in the Full Pattern region, and

1Md in the extended clay region, then illite may be counted twice in the final analysis.

If you develop your own standards, be sure to purchase a large quantity of ZnO, all from

the same chemical lot, to use as a constant internal standard through the years.

Gypsum (CaSO4.2H20) may be converted into bassanite (CaSO4.0.5H20) during grinding

in alcohol.  To prepare a gypsum standard, grind selenite crystals, which often do not convert.

To prepare a bassanite standard, heat gypsum to 150 C overnight.  An equation for correcting

gypsum weight percents for bassanite conversion during ginding is located in the Results sheet.

During sample preparation, after grinding in methanol and drying the sample, be sure to

pass all of the sample mixture through the sieve, and then mix the sieved sample thoroughly

before side packing it into the holders.  This procedure insures that the ZnO internal standard,

which may segregate during drying, is uniformly mixed with the sample.

Standardless analyses always sum to 100 percent, but this does not mean that these

results are better than those run with an internal zincite standard.  Both methods should give the

same answer if all of the minerals present in a sample have been chosen to be present in the

program.

The most common reason for analyses >>100% is insufficient homogeneity in the

analyzed mixture for the zincite internal standard.
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Large amounts of pyrite will cause the Shifter to find the wrong peak if option 1 is used

in the Shifter sheet.  In this case, change cell B8 in the Shifter sheet to option 2.

Enter corundum (McCrone) into every analysis to correct for contamination from grinding

elements, but do not report it as a part of the analysis.  This is done by entering 1’s into cells

H73 and K73 in the Input sheet.

Excel is not optimized to run on Macintosh system X, and therefore RockJock normally

will run faster on a PC.

The McCrone grinding vials can be prevented from leaking by cutting a Viton rubber disk

to fit inside the upper screw cap.

When entering data always use COPY and PASTE.  Never use CUT and PASTE.  The

latter command may change references in related cells.  When pasting, under the EDIT menu,

choose PASTE SPECIAL, VALUES.  This routine insures that only the numbers are pasted, and

not equations in the copied cells.

The program sometimes crashes, especially when run under the Xp system.  It rarely or

ever crashes during a calculation, but too often crashes when the contents of a cell are changed.  If

this happens, do not try to recover the program, because a cell that directs the Solver has been

corrupted.  Simultaneously type the CONTROL-ALT-DELETE keys to interrupt the saving

process, click the END TASK button, and restart the RkJock5.xls program.

It would be good to experiment with the Auto Background correction (enter 1 in cell B16

of the Input sheet) to see if this option is necessary to use with your experimental setup.

If you use the standards that are currently in the program, run artificial mixtures to check

that RockJock is giving good answers for your experimental setup.

For Mac users, it may be necessary to close all Excel worksheets except RockJock to get

the program to run.
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APPENDIX 1: INPUT SHEET INPUTS AND OUTPUTS

Summary of inputs for the Input sheet.

Input Cell Value Comments

Sample name and

XRD intensities

D1 and

following

Name and

intensities

Enter sample name in cell D1, and sample XRD

intensities in cells D2 through D3002.

Sample name B3 None Do not enter a name.  Name is entered

automatically from cell D1 when program is run.

Starting angle for X-

ray intensities

B5 Usually 5

degrees

Should be 5 degrees or smaller for quantitative

analysis.

Step size B7 0.02 Must use 0.02 for quantitative analysis unless all

of the standards are changed to a different step

size.

Radiation wavelength B9 1.5418 Program is currently set up for Cu K-alpha

radiation.  Some changes in the program will have

to be made to use other wavelengths.

Auto analysis? B11 0 or

positive

whole

number

Enter the number of patterns that were entered into

the Auto XRD sheet.  A zero leads to analysis of

the single pattern that was entered into column D

of the Input sheet.
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AutoShift standard

patterns?

B14 -1 = set all to

zero; 0 = keep

present shifts;

1,2,or 3 = shift

for type of

analysis

indicated.

Shifts the standard patterns with respect to two-

theta during the Solver solution to account for

isomorphous substitutions, etc.  Slows the

calculation.

Auto background

correction?

B16 1 = yes Causes the background to be a part of the Solver

solution.  Enter 1 if the samples are run on different

instrument than standardsor to correct for Fe

fluorescence.

Collect results or reset

defaults

B18 0, 1 or 2 0 turns this feature off.  1 pastes results from Full

Pattern sheet into Results sheet.  2 returns inputs

to default values.

Type of analysis B22 0 through 4 Performs the type of action indicated on the Input

sheet in cells B20 and B21.  0 = plots sample XRD

pattern with no shift; 1 = plots pattern with shift

against internal standard (position standard is set in

Shifter sheet, usually ZnO); 2 = Full pattern

analysis; 3 = Full pattern analysis with extended

clay analysis; 4 = Standardless analysis.

Start angle C4 Angle Starting angle for manual peak analysis

End angle C6 Angle >C4 Ending angle for manual peak analysis.

Auto pick left

background?

C8  0 = no;

1 = yes

If 1, finds minimum on left side of peak.

Otherwise the value used is that entered in cell C4.
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Auto pick right

background?

C10 0 = no;

1 = yes

If 1, finds minimum on right side of peak.

Otherwise, the value used is that entered in cell C6.

Background correction

type

C13

0 through 4

Removes background according to description in

cells B11 and B12

Solver convergence C18 1 to 3 Specifies value at which Solver will be satisfied that

it has found a solution in comparing the calculated

to the measured XRD pattern.

ZnO/sample ratio C21 Wt ZnO/wt

sample

Normally 0.111 (0.111g ZnO/1g  std), but use 0.25

for standards [for standards, wt.ZnO/(wt standard

+ wt kao or qtz) = 0.6g/(1.2g + 1.2g)].

Watch calculation? M25 1 = yes Turns on screen during calculation.  Slows

calculation.

Smooth Power M27 Enter whole

number

Smoothes measured XRD pattern, with larger

number causing more smoothing.  Enter 1.

Auto save after auto

analysis?

M29 Enter 1 or 0. Saves program and results after auto analysis run.

Enter 1.

Number of iterations

for AutoShift

M31 Enter whole

number.

Causes the calculation to iterate the number of

times entered when solving for shifts.  Enter 1.

Progressive

AutoShift?

M33 Enter 0 or 1 If 1 is entered, shifts are not erased after each auto

analysis sample.  Enter 0.

Print each result? M35 1 = yes Causes each result during auto analysis to be

printed.  Enter 0.
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Starting and ending

two theta for full

pattern analysis.

M37

&

M38

Enter 20 and

65

Indicates what part of the pattern should be

analyzed during full pattern analysis.

Starting and ending

two theta for extended

clay analysis

M40

&

M41

Enter 58 and

65

Indicates what part of the pattern should be

analyzed during full pattern analysis.

Use extended factors

in Auto Graph

M43 0 or 1 0 = uses Full Pattern factors in Auto Graph; 1 =

uses Extended clay factors.
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Summary of outputs for Input sheet.

Output Cell Value Comments

Position of XRD peak

maximum

A4

and

A5

Gives two-

theta value and

d-spacing of

chosen peak

Peak is chosen as the maximum intensity between

the two-theta values entered into cells C4 and C6.

Analysis range A7

and

A8

Chosen two-

theta values for

peak analysis

Gives the analysis range chosen for the peak in

cells C4 and C6.

Maximum intensity of

peak

A10 Intensity Gives maximum intensity of chosen XRD peak.

Angles for tail

minimums

A12

and

A13

2-theta for left

and right sides

of  peak

If cells C8 and C10 = 1, then the two theta values

are the minimum values for the peak.  Otherwise,

they are the values entered into cells C4 and C6.

Integrated intensity A15 Integrated peak

intensity

Integrated intensity between angles given in cells

A12 and A13.

Integral peak breadth A17 Integrated/max

intensity

Peak intensities are integrated between two-theta

values found in cells A12 and A13.
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APPENDIX 2:  SHIFTER SHEET INPUTS AND OUTPUTS

Input or Output Cells Value Comments

Choose internal two-

theta position

standard

B7 Enter 1

through 5,

depending on

the position

standard

chosen.

Normally use 56 and 57 degrees to find top of 110

ZnO peak.  Sometimes the sample will interfere

with this peak (especially true for pyrite standard),

in which case, the 103 ZnO peak should be used.

Quartz or no shift should be used for standardless

analysis.

Set angles B13

&

B14

6 to 64 degrees Sets angles for position standard that was entered

into column J.

Steps for shifting

sample

B16 Positive or

negative whole

number

This cell automatically adjusts when program is

run.  However, the pattern also can be shifted

manually by entering a positive or negative whole

number into this cell, and turning off shifter.
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APPENDIX 3: FULL PATTERN SHEET INPUTS AND OUTPUTS

Input or Output Cells Value Comments

Choose two-theta

regions for Solver

analysis

B4 to

B9

Usually

20-65

degrees.

By changing cells B6 to B9, other two-theta regions

also can be entered into the analysis.  For example,

low-angle peaks can be included in the analysis, or

certain peaks can be excluded, in cooperation with cells

M30:M35 of the Input sheet.

Shift standard patterns C8 to

C47

Positive or

negative

whole

number

Shifts standard patterns with respect to two-theta.

After initial Solver solution, shift patterns manually

using these cells to minimize the degree of fit value in

cell E1.  Then run the program again. Cells C6 and C7

shift the measured pattern and the ZnO pattern,

respectively, and, therefore, always should be set to 0.

Standard pattern factors E7 to

E47

Decimal These cells are varied automatically during the Solver

solution, and are multiplied by the intensities of the

stored standard XRD patterns.  But they also can be

manipulated manually to change the proportions of the

standard patterns in the graphs.

Bragg’s Law D50

to

D59

Enter d-

spacing or

two-theta

To calculate XRD peak positions or spacings.
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Solver model C60:

C71;

D60:

D63

Solver

setup

Controls Solver settings for Full Pattern and shift

analyses, respectively.
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APPENDIX 4: RESULT SHEET INPUTS AND OUTPUTS

Input or Output Cells Value Comments

Calculation time A1 to

A6

Time and

date

Gives calculation time.

Weight percent minerals,

shifts, and type of

analysis

Cols.

A to

D

Weight

percents,

steps

shifted, and

option run

The weight percent total should be approximately 100

percent.  Normalized values also are presented.

Warnings Col

G

Normally

hidden text

Warns about non-standard settings in the program.

Weight percents from

full pattern and extended

clay analyses

Cols.

J &

K

Percents The results of the two types of analyses can be

compared for each phase if the extended clay option is

used (enter 3 in cell B22 in Input sheet).

ZnO sample ratio Q1 Normally

0.111

(Weight ZnO)/(weight sample).  This value is set in

cell C21 of the Input sheet.

ZnO correction factor O2 Set to 1. Method for normalizing results when using different

sources of ZnO (see manual).

Corrected ZnO/sample

ratio

Q2 Equals O2 x

Q1

It is an output, so do not change it.

Automatic calculation of

MIFs

Col

U,A

BA

Calculates

MIFs for

standards

Standards need to be prepared correctly.  See standards

section in this manual. Cols BA and BB are for impure

standards.
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APPENDIX 5: STANDARDS SHEET INPUTS

Input or Output Cells Value Comments

Standards table Col B

to

Col

H

Enter

information

for

standards

Enter information about the standards, as is described

in this manual, including sample name, integrated

intensities for Full Pattern (20-65 degrees) and Clay

(55 to 65 degrees) regions, MIFs for each region, and

sample descriptions.

Intensities for pure

standards

Start

in

Col

M

XRD

intensities

for

standards

Start at 5 degrees and use 0.02 degree steps.  Do not

remove background.  Note that column in which

intensities are entered is related to position in

Standards table (see above).  Standards need to be

shifted to their true two-theta value with respect to the

110 zincite peak.
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APPENDIX 6: AUTO XRD SHEET INPUTS

Input Cells Value Comments

Intensities for samples

to be analyzed in series

of analyses.

Start

in

Col C

XRD

intensities

Start at 5 degrees and use 0.02 degree steps.  Put the

sample name in the first row, followed by intensities.

Set value of cell B11 in the Input sheet to the number

of patterns to be analyzed that are contained in the

Auto XRD sheet.
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APPENDIX 7: AUTO RESULTS SHEET OUTPUTS

Output Cells Value Comments

Time for calculation A1 to

A6

Time and

dates

Gives starting and ending times, and dates for

automatic calculation.

Results of Auto

calculation

Start

in

Col C

Weight

percents

Pattern number in row 1 is used to identify result in

Auto Graph sheet.  Results are completely erased if

new Auto calculation is started.
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APPENDIX 8: AUTO GRAPH SHEET INPUTS

Output Cells Value Comments

Pattern number A2 Whole

number

Entering pattern number produces graphs and weight

percents for each auto analysis.  Pattern number

corresponds with number for result shown in Auto

Results sheet.  This page can be saved separately, as is

described in the ‘Using the Automatic Mode’ section

of the instruction manual.
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APPENDIX 9:  RESOURCES FOR QUANTITATIVE MINERAL ANALYSIS

Sources of standard minerals:

Source Clay Minerals Repository
Purdue University
1150 LILY Hall
West Lafayette, IN 47907-1150  USA
Voice: (765) 494 4258   FAX: (765) 496 2926
E-mail: sourceclays@purdue.edu
Web: http://cms.lanl.gov (follow links to Source Clays Project)

Ward’s Natural Science
5100 West Henrietta Road
P.O. Box 92912
Rochester, NY 14692-9012 USA
Voice:1-800-962-2660   FAX: 716-334-6174
International calls: 716-334-6174
Web: http://www.wardsci.com/online_catalog/

Excalibur Mineral Corp.
1000 North Division Street
Peekskill, NY 10566 USA
Phone: (914) 739-1134
Email: info@excaliburmineral.com

Trinity Mineral Company
John Veevaert
P.O. Box 2182 Weaverville, California 96093-2182  USA
Phone: (530) 623-2040;   (888)-689-8402 (Toll Free)
Email: john@trinityminerals.com

David Shannon Minerals
6649 East Rustic Drive
Mesa, Arizona 85215  USA
Phone: (480) 985-0557.
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Mineralogical Research Co.
15840 East Alta Vista Way
San Jose, California  95127-1737  USA
Phone: (408) 923-6800

McCrone Micronising Mill:

McCrone Associates
850 Pasquinelli Drive
Westmont, IL  60559  USA
Voice:  800-622-8122;  Fax: 630-887-7764
Web:  http://www.mccrone.com/mac/home2.html

Jade XRD search-match software:

Materials Data
1224 Concannon Blvd.
Livermore, CA 94550  USA
Voice: 925-449-1084;  FAX:  925-373-1659
Web:  http://www.materialsdata.com

Information concerning the Solver:

Frontline Systems Incorporated
Voice: 775-831-0300
Web site:  http://www.solver.com

Microsoft Excel:

Web site:    http://www.microsoft.com/office/excel/default.asp   
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APPENDIX 10:  ANALYSES OF REYNOLDS CUP SAMPLES

Table 3.  Comparison between true values for artificial mixtures used in the 2002 Reynolds Cup

quantitative analysis competition, and those calculated from XRD patterns using Option 2 in the

RkJock5.xls program.  Reynolds Cup samples prepared by Douglas McCarty.  RockJock

analyses are normalized to 100 %, and all minerals in the first column were entered into RockJock

as present for all three samples.  Combined biases are calculated using totals for 2:1 clays, rather

than the individual 2:1 clays.

Sample: RC-AR1 RC-AR2 RC-AR3

Mineral TRUE RkJock5 TRUE RkJock5 TRUE RkJock5

Quartz 20.0 20.4 40.0 40.4 15.0 15.6
Microcline 9.0 9.2 11.0 10.6 2.0 2.7

Albite 7.0 9.1 9.0 11.5 2.0 2.8
Calcite 5.0 6.0 3.0 3.2 17.0 20.1

Dolomite 3.0 3.2 2.0 2.0 5.0 4.8
Siderite

 (shift of +12)
3.0 2.4 2.0 1.6 5.0 4.2

Halite 3.0 2.6 2.0 0.6 2.0 1.5
Pyrite 2.0 1.5 3.0 2.1 2.0 1.2

Gypsum 0.0 0.1 0.0 0.1 5.0 1.8
Barite 2.0 2.4 2.0 2.2 2.0 2.4

Kaolinite 9.0 9.7 7.0 7.0 10.0 8.9
Total 2:1 clays 32.0 26.4 15.0 13.8 33.0 33.6

Fe-smectite 7.0 0.0 6.0 4.1 5.0 3.9
Illite 1M 25.0 26.4 9.0 9.7 28.0 29.7

Chlorite 5.0 7.0 4.0 4.8 0.0 0.4

Total 100.0 100.0 100.0 100.0 100.0 100.0

Detailed bias -- 17.0 -- 9.9 -- 15.4
COMBINED BIAS -- 14.2 -- 8.5 -- 13.2
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Table 4.  Comparison for 2004 Reynolds Cup samples.  Reynolds Cup samples prepared by
Reinhard Kleeberg.  RockJock analyses are normalized to 100 %, and all minerals in the first
column were entered into RockJock as present for all three samples.  Combined biases are
calculated using totals for plagioclase, kaolinite group and 2:1 clays rather than the individual
minerals in these groups.

Sample: RC2-1 RC2-2 RC2-3

Mineral TRUE RkJock5 TRUE RkJock5 TRUE RkJock5

Quartz 24.8 23.7 45.7 44.1 14.7 13.3

K-feldspar 8.5 10.2 9.2 9.0 2.1 1.8

Plagioclase group 6.5 6.4 10.7 13.1 2.9 4.1

albite 6.5 6.0 4.0 4.3 0.0 0.0

oligoclase 0.0 0.0 6.7 3.3 2.9 2.4

andesine 0.0 0.3 0.0 5.4 0.0 1.7
Calcite 5.0 5.0 0.0 0.0 18.6 19.5

Dolomite 2.0 2.0 0.0 0.1 6.0 6.0

Magnesite 0.0 0.0 0.0 0.0 4.9 4.5

Halite 0.0 0.0 0.0 0.0 1.5 1.0

Pyrite 2.5 1.9 0.0 0.1 0.0 0.0

Anhydrite 0.0 0.0 0.0 0.0 14.6 14.0

Hematite 0.0 0.0 2.5 1.9 0.0 0.0

Anatase 0.1 0.0 1.5 0.2 0.0 0.0

Rutile 0.0 0.0 1.5 1.7 0.0 0.0

Kaolinite group 16.0 17.2 15.4 17.0 0.0 3.2
kaolinite 16.0 17.2 9.9 12.6 0.0 3.2

dickite 0.0 0.0 5.5 4.4 0.0 0.0

Total 2:1 clays 30.1 30.8 10.5 11.1 25.1 23.3
illite 1Mt 10.5 10.9 5.5 4.0 0.0 2.5

I/S mixed layer 10.1 8.8 0.0 3.3 0.0 5.4

montmorillonite 9.5 9.4 0.0 0.0 8.0 2.4

muscovite + illite 2M1 0.0 1.7 5.0 3.8 17.1 13.0

Chlorite 4.5 3.0 3.0 1.7 9.6 9.4

Total 100 100 100 100 100 100

Detailed bias -- 10.5 -- 24.3 -- 27.4
COMBINED BIAS -- 7.1 -- 9.9 -- 10.6
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Figure 2.  The Reynolds Cup trophy,  awarded once every two years to the winner of an
international quantitative mineral analysis competition (see
http://www.dttg.ethz.ch/reynoldscup2004.html).
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Abstract submitted to the 2002 meeting of The Clay Minerals Society:

HOW I WON THE REYNOLDS CUP*

The Clay Doctor, Dept. of Earth, Wind, Fire and Water Sciences, Clayhead University, 9-10 Big Fat Hen Road, Rockland,
BA 00002

I suddenly became interested in minerals at a very young age,  when other children began to throw
rocks at me.  Rocks that contained clay hurt less; so I began to wonder how much kaolinite was in this one,
how much galena in that.  My father bought me my first X-ray diffractometer when I was 10,  and there
was no turning back.  While other children were reading Tales from the Crypt Comics,  and later Hustler
Magazine,  I was reading the X-ray Powder Diffraction Card Files, memorizing d-spacings.  So when Dr.
Douglas McCarty from ChevronTexaco sent me the three unknowns that contained mixtures of pure
mineral separates,  I was ready to analyze them quantitatively.

I analyzed the samples as follows.  They came in the mail in an Airborne Express pouch.  I opened
the pouch with a dry-wall knife that is kept in the second drawer from the top in the X-ray lab.  It is the type
that has a retractable blade.  Then I removed the bottles from the package,  and analyzed them.

I am so undeserving of this honor,  but I am happy to have become the first winner of the Reynolds
Cup.  I would like to thank my parents,  my music teacher,  and the little gal who let me make a left turn into
the parking lot this morning.  I especially thank Dr. McCarty for mistakenly sending me the answers along
with the bottles,  which saved a lot of analysis time.  I realize that in accepting this award I will be
responsible for helping to organize the next competition.  Also,  I understand that the Cup is not
permanently mine,  but that it will circulate to the next winner.  Therefore,  in some ways,  the Reynolds
Cup is similar to the Stanley Cup,  except for the hockey.  Now I kiss the Cup,  raise it above my head,  and
run around the meeting room yelling,  wrapped in a flag.

In the (unlikely) event that I do not win,  I will relinquish this time at the podium to the real winners
so that they can explain how they won the Reynolds Cup.

*Note: The Clay Doctor was later disqualified for failing a random drug test.


